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Forward     
                      

This guide supports the Army Enterprise Service Desk (AESD) helpdesk to troubleshoot and 

diagnose problems that users may have with Skype for Business Online or Client.  This guide 

offers recommended practices as a strategy to resolve the user’s problems.  This document 

supports the mission of “The Service Desk to provide a strategic central point of contact between 

the Army IT users and the Army IT services being provided.”  

Some of the content in this document was retrieved from the Microsoft support website for 

Skype for Business 2015 at https://support.office.com/en-us/skype-for-business. Utilization of 

the Skype for Business application is considered a government information system and as such, 

is subject to monitoring and recording per AR 25-2 and DoDI 8500.01. 
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Section 1 - Signing into Skype for Business  
 

1.1 Sign into Local or Telework Personal Computer (PC) 
The Army Enterprise Service Desk (AESD) uses the Single Sign-On (SSO) of the user to log 

into local desktop PCs or remote teleworking PC’s. If you are unable to login with your SSO, 

please contact AESD for assistance.   

1.2 Verify installation of Skype for Business on PC 
1.  Navigate to Windows Symbol on Task Bar located on the bottom (most cases), left, right, 

or top of the screen. 

2.  Click on  to show Programs and Applications.  Scroll down with mouse to “S” category 

to find Skype for Business. If missing, contact your PC support team to install it. 

 

 

 

 

 

 

 

 

 

 

 

 

1.3 Adding Exception Site List in JAVA 
1.  Open the “Control Panel” on your computer and then double-click the Java icon to 

open the Java Control Panel or Programs and Click on JAVA → Configure JAVA. 

2.  Once in the JAVA Control Panel, select Security Tab 

3.  Add the 3 sites below to the Exception Site List 

a. https://www.dmdc.osd.mil  

b. https://pki.dmdc.osd.mil  

c. https://idco.dmdc.osd.mil 

4.  Click Apply/OK          

 

 

Back to Table of Contents 
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1.4 Activating your PIV Certificate 
1. Before accessing Skype for Business, you must first download your PIV certificate. 

Go to: https://www.dmdc.osd.mil/self_service/ 

 

 

 

 

  

1. Click Sign 

in 

2. Click 

OK 

3. Select CAC Login 

and follow 

directions 

1 

3 

2 
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4. From the “Home” page, 

click Activate PIV 

Certificate 

 

Note that if you have 

more than one CAC (i.e. 

Civil Service and 

Reserve), multiple CAC 

information boxes will 

display. Click the action 

in the box associate with 

the CAC that you want to 

update.   

 

 

 

 

5 

5. Click Proceed to continue activating the PIV Authentication 

certificate associated with your CAC. Click Update CAC if 

prompted. The progress of your task is displayed.  Once IDCO 

has completed process, the screen will notify you of successful 

completion.  

Back to Table of Contents 
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1.5 Signing into Skype for Business 
Enter the email address from the Welcome letter/email for a new user of SfB in the proper 

format. It should look something like first.last.mil@usa.army.mil. Be sure to use your 

organization credentials, not your personal Skype Name or Microsoft account.  Enter it in the 

Sign-in address block. 

Note: If you are signing into Skype for Business for the first time, enter your sign-in 

address, click Sign In, enter your CAC PIN, and click Sign In again.  Make sure that SfB 

starts automatically when you log on to Windows (see 2.2 Personal to verify). 

 

 

 

 

 

 

 

 

 

 

 

Make sure that SfB starts automatically when you log on to Windows (see 2.2 Personal to verify). 

1.6 Verify Entries in Registry 
Check for the following two registry keys entries on the user’s equipment. 

REG ADD HKCU\SOFTWARE\Microsoft\Office\15.0\Common\Identity /v EnableADAL 

/t REG_DWORD /d 1 

 

REG ADD HKCU\SOFTWARE\Microsoft\Office\15.0\Common\Identity /v Version /t 

REG_DWORD /d 1 

 

If the entries are missing, use PowerShell to enter the following commands and then reboot. 

 

 

 

 

1. Enter sign-in address in the 

Sign-in address block 

3.  Click Sign In. 

 

 2. Enter CAC PIN in the 

Password block 

 

Ck    

first.last.mil@usa.army.mil 
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1.7 Check DLL File Version 
The client version of Skype for Business requires DLL versions 15.0.4771.1001 and above for 

Modern Auth.  This applies to MSO.DLL, CSI.DLL, Lynce.exe, and ADAL.DLL requires 

version 1.0.2016.624 and above. 

The DLL files are located in the following. 

MSO.DLL  

C:\ Program Files <(x86) or (x64)>\Common Files\Microsoft Shared\OFFICE15 \MSO. DLL 

 

CSI.DLL 

C:\ Program Files <(x86) or (x64)>\Common Files\Microsoft Shared\OFFICE15\CSI.DLL 

 

ADAL.DLL 

C:\ Program Files <(x86) or (x64)> \Common Files\Microsoft Shared \OFFICE15\ADAL. 

DLL   

 

Lync.exe 

C:\Program Files <(x86) or (x64)>\Microsoft Office\Office15\lync.exe 

 

• You can verify the version numbers of each file using Windows Explorer and hovering 

your mouse over the file to display file details or by right-clicking the file, selecting 

“properties” and then going to the “details” tab. 

• If your file versions are above the minimal requirement, please consult your designated 

IT Support Staff. 

• If the file versions ARE NOT above the minimum requirement, your designated IT 

Support Staff will need to push updated .DLL versions to the PC. 

• You must reboot the equipment when the.DLL files are updated. 

 

1.8 Running Repair on an Installed Copy of Skype 
 

• Your IT Support staff must log in to equipment as an admin to complete this task. 

• Open Control Panel and select “Programs and Features.” 

• Select the Skype program and select “Repair.” 

• Once completed, reboot the equipment. 

 

 

 Back to Table of Contents 
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1.9 Check Communication with Port 49443 
 

• Open Windows PowerShell and run the following command to check port 49443. 

• Test-NetConnection -ComputerName sts.usa.army.mil -Port 49443 

• You want to get a return of TRUE for “PingSucceeded” if you get a reply of FALSE, this 

needs to be reported to AESD or your local NEC and they will act accordingly. 

• Once AESD or your local NEC reports this issue is remediated, please go to section 1 and 

try to sign back into skype. 

 

 

 

 

 

 

 

 

 

 

 

1.10 Resetting the Sign in password 
If you recently changed your CAC PIN, you will need to enter your new CAC PIN in Skype for 

Business. As a standard requirement for companies, employees must change passwords 

periodically for security purposes. 

 

1.  Open the Skype for Business sign in screen. 

 
Note: If you are stuck at "Contacting server and signing in," click Cancel Sign-In. 

 

 

 

              

                  

       

Back to Table of Contents 
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3.  In the window that 

appears, click Yes. 

 

2. Click on Delete my 

sign-in info 

Back to Table of Contents 
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5. Under Password, 

enter your CAC PIN. 

4.  Click Sign In. 

 

6. Click Sign In. 

Back to Table of Contents 
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1.11 Checking Installed Version of Skype for Business 

1.  Open the Skype for Business main window, click the Options button  and select Help, 

then About Skype for Business. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Back to Table of Contents 



18 | P a g e  
ATTAP-A018-1-A 

Section 2 - Checking Skype for Business Settings 
 

2.1 General 
In General options, the window allows setting up formatting for instant messages, help 

Microsoft improve Skype for Business, help your support staff troubleshoot issues, and set 

where Skype for Business is available from when closed. 

 

Accessing the General options window: 

1.  In the Skype for Business main window, click the Options button  and select General. 

Or click the arrow next to the Options button on the right   and select Tools > Options. 

 

 

 

   Or  

 

 

 

 

2. On the Options page, select General. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Back to Table of Contents 



19 | P a g e  
ATTAP-A018-1-A 

Conversation window preferences 

The conversation window selections determine whether Skype for Business preserves your 

conversation display between sessions and what happens when Skype for Business moves to 

the background during an active conversation. 

 

• If you want Skype for Business to remember which conversations are in the tabbed display 

whenever you sign out and automatically redisplay those conversations the next time you sign 

in, select Reopen my conversations when I sign in. 

 

• To display shortcut call controls if your active Skype for Business meeting is moved to the 

background, select Show call controls when Skype for Business is in the background. 

 

Help improve Skype for Business 

 

Selecting this option automatically sends error information to Microsoft specifically about 

Skype for Business, such as error logs, device configuration, and info about how the 

application is used. This information can help fix problems and improve the product.  

 

• To contribute Skype for Business error information, select Send Skype for Business 

Improvement Program info to Microsoft. 

 

Set logging options to help your support team 

 

System logs help to analyze problems. The organization's technical support team might 

occasionally ask you to collect logs to help with troubleshooting. If they want you to collect log 

information about Skype for Business, the Help your support team help you section is where 

you can initiate log collections. 

 

• To change the logging level, in the Logging in Skype for Business list, select Full creates a 

log file that contains detailed information, Light (default) records summary information and 

gathers info about specific errors, or Off. Ask your technical support person which to 

choose. 

 

• Sometimes Windows event logs can provide clues to issues with Skype for Business. To 

turn Windows Event logging on, select Also collect troubleshooting info using Windows 

Event logging. 
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Set Application window 

 

In Skype for Business, when you click the Close (X) button in the upper right corner of the 

main window, Skype for Business keeps running so that you can receive alerts of incoming 

calls or messages. By default, clicking the Close button minimizes Skype for Business to the 

taskbar. However, you can choose to have the Skype for Business window minimized to the 

notification area (located at the far right of the taskbar) instead of the taskbar by 

selecting Minimize to the notification area instead of the taskbar. 

 
Note: If you choose this option, it does not take effect until you exit and then open Skype 

for Business. In the Skype for Business main window, click the Options menu, click File, 

click Exit, and then sign back into Skype for Business. 

 

2.2 Personal 
The Personal options window in Skype for Business allows you to change your sign-in settings 

to speed up the sign-in process, specify presence and calendar meeting information to display 

to others in Skype for Business and tell Skype for Business how you want it to interact with 

other Office programs. 

1. In the Skype for Business main window, click the Options button  and select Personal. 

Or click the arrow next to the Options button on the right   and select Tools > Options. 

 

To change the sign-in address 

Under My account, in the Sign-in address box, type the name of your user account. 

 

 

 

 

Note:  If your organization uses Office 365, do not change the Advanced setting, because  

Office 365 requires Automatic configuration. 

 

To automatically sign in and start Skype for Business  

Under My account, select the Automatically start the app when I log on to Windows 

checkbox. 

 

Stop automatically sign-in and start Skype for Business 

Under My account, clear the Automatically start the app when I log on to Windows 

checkbox.  
 

Start the app in the foreground 

If you want the Skype for Business main window to open in front of other open windows when 

it starts, select the Start the app in the foreground check box. If this option is not selected, 

the Skype for Business icon appears in the Windows notification area (system tray) when 

Skype for Business starts. 

 

 

Back to Table of Contents 
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Exchange and Outlook integration options 

Select Sync contact info between Skype for Business and Exchange option to engage the 

sync of contacts between the two applications. 

 

Update my presence automatically show when you are in a meeting  

 

Under Exchange and Outlook integration, select the Update my presence based on my 

calendar information check box. To specify who can see this information, use the following 

settings. 

 

 

 

 

To show this information to contacts in your Workgroup 

 

Select the Show meeting subject and location to contacts in my Workgroup privacy 

relationship checkbox. 

 

To show your Outlook Out of Office information to contacts 

 

Select the Show my Out of Office information to contacts in my Friends and Family, 

Workgroup, and Colleagues privacy relationships checkbox. Clear the check box to hide 

your Out of Office information from all your contacts. 

 

To save your conversation history or phone call history in Outlook 

 

Under Exchange and Outlook integration, select Save IM conversations in my email 

Conversation History folder checkbox allows storage of instant message history and phone 

call history. Clearing checkbox disables this feature. 

 

 

 

 

 

 

  

Location options 

 

Use the options under Location to specify whether Skype for Business shares your current 

location on your contact card and with other Office programs. 
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Under Location, select the Share my location information with other programs I 

use checkbox. 

 
Note:  If you choose this setting, all contacts (other than external contacts) can see your 

location. 

 

 

 

 

 

 

 

Show picture options 

 

Use the options under Show pictures to specify whether you want to see other peoples’ 

pictures. 

 

Under Show pictures, select or clear the Show pictures of contacts check box. The default is 

to show pictures. Pictures take more screen real estate, so if seeing more contacts in the list is 

more important to you then clear this option. 

 
Note: Clearing this box also means others cannot see pictures of you on Skype for 

Business and you can not see pictures of senders and receivers in IMs and group 

conversations. 

 

 

 

 

 

 

 

Advanced Connection Settings 

 

The Advanced Connection Settings dialog box next to Sign-in address provides optional 

configuration settings for Skype to connect to Skype for Business servers. 

 
Important:  Normally, you do not need to change your Skype for Business sign-in 

settings. Do not choose manual configuration unless your support team tells you to and 

provides detailed guidance on the correct values to use. 
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1. In the Skype for Business main window, click Options  and select Personal. 

 

2. Under My account, select Advanced. 

 

3. In the Advanced Connection Settings dialog box, select one of the two methods: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Automatic configuration 

Skype for Business Server automatically configure your connection settings. 

 

Manual configuration 

Caution: choose this if instructed by the support team and only if given the server names. 

 

• Internal server name  

type the FQDN (fully qualified domain name) of your Skype for Business Server. 

 

• External server name 

Type the FQDN (fully qualified domain name) of your Skype for Business Server 

or Edge Server. 

 

 

  

  

 

1. 2. 

3. 

Back to Table of Contents 
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2.3 Contacts Lists 

In the Skype for Business main window, click Options  and select Contacts List. 

These options change the display of your contacts in the main window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Display my contact with 

 

Under Display my contacts with, select Contact name and picture (two lines) to see a 

display in this format or select Contact name only (one line) to see contact list displayed in 

this format. 

 

Order my list 

 

Under Order my list, select By name to display only the names of contacts or By availability 

to display in availability groups. 

 

Show this information 

 

Under Show this information, select Contact name (instead of email address) to display 

only the contacts name.   

 

Select Contact status to display that status of the contact.   

 

Select Shows contacts with away, offline and unknown presences in a separate group to 

display in a different group than where it usually appears.  

 

Select Favorites group to display this group. 

 

 

 

 

 

 

  

 

Contacts List 
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2.4 Status 

In the Skype for Business main window, click Options  and select Status. 

These options change the display of your contacts in the main window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Show me Inactive or change my Status 

 

Under Status, Show me as Inactive when my computer has been idle for the many 

minutes is a time that changes yours to Inactive.  To change the time, use the up or down 

arrow next to the number.  Idle is when you have not used the mouse or struck any keys on 

the keyboard for a specified period.  

 

Change my status from Inactive to Away after this many minutes is changed by using the 

up or down arrow next to the number. 

 

Select I want everyone to be able to see my presence regardless of system settings 

(override default settings).  This overrides settings by the system administrator. 

 

Select I want the system administrator to decide – currently everyone can see my 

presence, but this could change in the future. The system administrator has control over 

your status setting. 

 

Select Show me as Do Not Disturb when I present my desktop.  This changes your status 

when actively presenting during a Skype for Business session. 

 

Select Show me as Do Not Disturb when my monitor is duplicated.  If during the 

presentation, you select to present using a monitor attached to your computer. 

 

 

Back to Table of Contents 
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 2.5 My picture 

In the Skype for Business main window, click Options  and select My picture. 

These options impact how your picture is displayed, adding or removing it on Skype for 

Business. 

 

Show or Hide My Picture 

 

Under My picture, selecting Hide my picture prevents your picture from showing on contact 

card and in the Preview window also. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Under My picture, selecting Show my picture allows people to see your picture if it is 

loaded and visible in Outlook or Office 365.  This shows your picture in the Preview window. 

 

 

Click Edit or Remove Picture to upload a picture if                                             

 

If it is greyed out the POP and IMAP settings of the email address may be incorrect.  Contact 

the appropriate department that has the correct settings for email accounts. 

 

Office 365 Outlook appears in a new window 
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The picture option box to delete, change or upload 

a photo appears.  To remove a picture in place, 

click Delete, then click Save to keep the current  

selection. To change a photo or load a photo for 

the first time click Upload photo and explore 

your computer files to find a photo, then  

click Save to keep the current selection. 

Click Cancel to close photo edit remove picture  

option box.  

 

 

 

 

 

To reopen the picture option box, Click Edit or Remove Picture to change, upload, or delete a 

picture        

 

 

Or, from Outlook window click on the edit pen  

to reopen the picture option box 

 

 

 

 

 

 

 

2.6 Phones 

In the Skype for Business main window, click Options  and select Phones. 

These options allow you to change your phone number and how it is displayed in Skype for 

Business. 
 

IMPORTANT: If you want to change your phone number but cannot because it is 

grayed out, it means your admin has set it for you and is blocking you from changing it. 

Contact your admin (the person who gave you your account information) and ask them 

for permissions to change your work phone number. 
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My phone numbers 

 

1. Click the box for the type of number 

 you want to add or change and enter 

 the number.  

 

Use only the digits 0123456789, 

 and no parentheses or hyphens.  

 

When adding international numbers,  

type the + sign, then the country 

code followed by the local number. 

 

 

2. To make this number visible to contacts, select the Include in my contact card check 

box next to the number. 

 

Who can see my phone number? 

 

Your phone numbers show up on your contact card and are visible to your Skype for Business 

contacts based on the privacy relationship they have with you. Your number is visible as 

follows: 

 

• Work Phone is visible to all contacts except your External Contacts and Blocked 

Contacts. 

 
Note: Some companies do not allow you to clear the Include in my contact card checkbox 

for your work phone. 

 

• Mobile Phone is visible only to your Workgroup, Friends, and Family. 

 

• Home Phone is visible only to your Friends and Family. 

 

• Other Phone is visible only to your Friends and Family. Use this option to add or 

modify additional numbers, like for a temporary office or an alternate cell phone. 
 

Phone Integration 

 

This option is grayed out and set by your administrator. 
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Use a text telephone (TTY) device 

 

The Text telephone (TTY) mode is used for text communication over a telephone line. A TTY 

device must be connected to the computer to interpret the modified audio. Using TTY mode 

in a conference call may also cause audio quality issues. 

 

TTY mode is off by default. To turn it on: 

 

1. Connect a TTY device to your computer. 

 

 

2. Under Phone accessibility,  

    select Turn on TTY mode. 

 

3. Sign out of Skype for Business, and then sign in again. 

 

2.7 Alerts 
 

Skype for Business shows alerts in several situations such as when someone adds you to their 

contacts list, or when someone initiates a conversation. The Skype for Business Alerts page 

lets you decide when, where, and from whom you see alerts. 

 

In the Skype for Business main window, click Options  and select Alerts to display options 

available. 
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General alerts  

 

Select the Tell me when someone adds me to his or her contact list check box. Then, from 

the Display and Position fields, specify on which monitor and where you want this alert to 

appear. 

 

 

 

 

 

 

 

When you select this setting, and someone adds you as a contact to their contacts list, in 

addition to an alert, Skype for Business adds that person to a running list of people you might 

consider adding to your own contacts list. You can review this list by clicking the New tab on 

the contacts view of the Skype for Business main window. Look at the list of potential 

contacts, decide whom to add to your own contacts list and can assign privacy relationships to 

those new contacts. 

 

 

 

 

 

 

 

 

 

Clear the Tell me when someone adds me to his or her contact list checkbox if you do not 

want an alert when someone adds you as a contact and do not want to automatically add 

people to your contact list if they have added you to theirs.   

By selecting this option, you do not see contacts on your New list. Anyone who adds you to 

their list is automatically added to your contacts list and is assigned the same privacy 

relationship of a colleague. 

 

When my status is Do Not Disturb 

 

Setting your status to Do Not Disturb reduces the number of interruptions you get. However, 

you may still want to keep in touch with key contacts. You can make exceptions for contacts 

to whom you have assigned the Workgroup relationship (typically your closest co-workers). 

 

Under When my status is Do Not Disturb, select one of the following options: 

 

• Click Don’t show alerts to hide all Skype for Business alerts so that you cannot be 

interrupted. 
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• Click Show only conversation alerts from people in my Workgroup privacy 

relationship to see only conversation requests from Workgroup members and hide all 

other alerts. 

 

• Click Show all alerts, but only conversation alerts from people in my Workgroup 

privacy relationship to see all alerts, but limit conversation requests to those sent by 

Workgroup members. 

 

Contacts not using Skype for Business 

 

Skype for Business supports having Skype users as contacts (when the Skype user is signed in 

with their Microsoft account) if your company is configured to support external contacts. For 

details, contact your workplace technical support. To be alerted to all, some, or no Skype for 

Business communications from Skype contacts, select the appropriate option under Contacts 

not using Skype for Business. 

 

2.8 IM (Instant Message) 
 

The IM options window in Skype for Business is where you can apply settings for spell-

checking, changing fonts, and showing emoticons in your instant messages. 

In the Skype for Business main window, click the Options button  and select IM. 
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The IM options page allow you can choose the following options. 

• Check spelling as I type  

Select this option if you want Skype for Business to flag misspelled words with a red 

squiggly underline. 

 

• Hide pictures in IM  

Select this option to show only your conversation in the IM window or tabbed panes, not 

pictures. 

 

• When copying IMs  

Choose whether you want to copy the message, name, and time, or to copy the 

message only. 

 

• Show emoticons in messages  

Select to show emoticons in instant messages. To display the typographical equivalents 

instead of emoticons, clear the checkbox. The emoticons are animated by default. If that 

is distracting, you can turn them off by clicking Turn off emoticon animations. 

 

• Enabled tabbed conversations  

Select to enable tabbed conversations. This option lets you keep track of several IM 

conversations at the same time. When you have more than one active conversation, you 

see a tab for each one in the upper-left corner of the conversation window. Just click the 

tabs to move back and forth among conversations. To limit the display of each tabbed 

conversation to one line, select the Make tabs one line only checkbox. 

 

• Change Font   

Click to change the default font size, style, and color of the instant messages you send. 

To apply those font preferences to the instant messages you receive, select the Apply 

settings to incoming messages check box. 
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2.9 Ringtones and Sound  

In the Skype for Business main window, click the Options button  and select Ringtones 

and Sounds. This option allows you to assign tones and sounds for different events that 

happen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Ringtones 

 

You can assign different ringtones to different groups of people if you would like. 

 

• In the Calls to box, select My work number, My team, People I manage calls for, 

or My Response Group calls then select a ringtone. Make sure the volume on your 

speakers is up so you can listen and decide if you enjoy that ringtone. Your selections are 

saved when you click OK. 

 

Sounds 

 

By default, Skype for Business plays sounds with specific events. However, there may be 

times when you do not want to hear sounds, like when your status is Do Not Disturb. 

 

• To stop all Skype for Business sounds, clear the Play sounds in Skype for Business 

(including ringtones for incoming alerts and IM alerts) check box. 

 

• To hear Skype for Business sounds, select the Play sounds in Skype for Business 

(including ringtones for incoming alerts and IM alerts) check box, then if you would 

like you can mute the sounds if you are in an IM conversation, or if your status is Busy or 

Do Not Disturb. 

 

• Your organization may also give you the option to listen to specific music while you are 

on hold during a phone call. Select Play music on hold if this option is available and you 

would like to hear music while on hold. Then click the Browse button to navigate to the 

music file you'd like to hear. 
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Set specific sounds 

 

1. Click the Sound Settings button. 

 

2. In the Sound dialog box, click the Sounds tab. 

 

3. Under Program Events, scroll down to Skype for Business. 

 

4. Click on an event (like Call Ended, for example). 

 

5. In the Sounds list, click a sound file. To hear it, click Test 

 

2.10 Audio Device 

In the Skype for Business main window, click the Options button  and select Audio Device. 

This option allows you to set up and use your computer’s built-in mic and speakers, a headset, 

or another device for Skype for Business audio.  

 

 
Important: If either the microphone or speakers are disabled, this error screen appears 

when selecting the Audio Device option.  Follow these troubleshooting steps to resolve the 

problem. If you are unable to perform the following steps, contact your computer 

administrator to assist. 
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Check Device Manager 

 

1. Open Start , type Device Manager, and select Sound, video and game controllers, 

select your sound card and open it.  

 

2. Make sure the device is enabled. If it is not, Enable Device. 

Each computer has a different name for audio devices such as a Basic Generic Audio Device.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If that did not work, try this: 

 

  1.  Open Start,          then type Sound,                                   then hit Enter. 

 

 

 

  2. Select the Playback tab 

 

 

 

 

 

 

  3. Select Speakers and make sure they are Enabled 

 

 

 

 

 

 

  

     

 

 

 1. 
2. 
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Check Sound to Enable Speakers 

 

4. To Enable Speakers, highlight speakers, and right or left click to display options to 

Enable. 

 

 

 

 

 

 

 

 

 

  5. Then Set Default Device. 

 

 

 

 

 

  6. Then click OK. 

 

 

 

 

 

 

 

 

  7.  Speakers are Enabled and Set Default 

  as indicated by the green check in a circle. 
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Check Sound to Enable Microphone 

 

  8. Select the Recording tab. 

 

 

 

  9. Check if the microphone is Enabled. 

 

 

  10. Set Default.  

 

 

 

 

 

 

 

 

Skype Audio Device Options 

In the Skype for Business main window, click the Options button  and select Audio 

Device. 

 

1. Under Audio device, choose the device you want. 

 

2. Click the green arrow next to Speaker to hear a sample tone and drag the slider if you 

need to adjust the volume. 

 

3. To test your Microphone volume, speak for a few seconds. The volume is optimal when 

the progress bar reaches the middle of the test area. Drag the slider next to Microphone to 

adjust the mic volume. 

 

4. Click the green arrow button next to Ringer to hear a sample ring when you get a call and 

drag the slider to adjust the ringer volume.  
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5. If you have more than one audio device, you can choose to set both to ring when you get a 

call. Under Secondary Ringer, select Also ring, and then select an additional device. 

You can also select Unmute when my phone rings; automatically unmute your speakers 

when you receive a Skype for Business call. 

 

6. Select Allow stereo audio playback when available to make sure that the best audio 

quality is available during a meeting. 

 

7. Click OK. 

 
Tip:  You can select different devices for microphone and speakers under each section. 

However, to avoid echoing, it is better to use the same device for both. If you must use 

separate devices, minimize possible echoing by lowering your speaker's volume. If you do 

not see your device in the list, make sure it is connected directly to your computer and 

follow the instructions that came with the device to install it. 

 

2.11 Video Device 
 

In the Skype for Business main window, click the Options button  and select Video Device. 

This option allows you to set up and use your computer’s camera to make a video call or share 

your video in a meeting, but you do not need one to receive a video call or see other people’s 

videos. 

 
Important: If the video camera is disabled, this error screen appears when selecting the 

Video Device option.  Follow these troubleshooting steps to resolve the problem. If you 

cannot perform the following steps, contact your computer administrator to assist. 
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Check Device Manager 

 

1. Open Start,         then type Device Manager, and select double click on Cameras select 

your camera, and double-click to open options. 

 

2. Make sure the device is enabled.  Each computer has a different name for camera devices 

such as a Basic Generic Video Device.  If not, Enable Device. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Skype Video Device Options 

 

1.  In the Skype for Business main window, click the Options        button select Video 

Device. You see what your camera sees in the window. 

 

 

 

 

 

2.  If you have more than one  

camera and want to switch, select it  

from the drop-down list. 

 

 

3.  For advanced settings like color 

 balance, contrast, brightness, and 

 black-and-white mode and more  

click the Camera Settings button. 

 

4.  Click OK when done. 

 

  

 

 

 

 

 

1.  

2. 
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Video Keeps Moving Around 

 

If your video is moving around during a meeting, Skype for Business is trying to keep you in 

the center of the sent video with the Crop and center my video in meetings feature that, by 

default, is turned on.  

 

1. If you want to disable this functionality, go to Options > Video Device settings. 

 

2. Clear the Crop and center my video in meetings check box. 

 

2.12 File Saving 
 

Sometimes, during a Skype for Business meeting--either the presenter or another participant 

may share a file (PowerPoint, Word, Publisher or others). You can specify a location to save 

these files in one convenient place. 

 

1. In the Skype for Business main window, click the Options button  and select File 

Saving.  

 

2. Under File transfer, click Browse to select the folder that you want to save received files. 

 

3. Click OK. 

 

2.13 Recording 

 
One of the neat things about Skype for Business is that you can record meetings. People who 

may have missed the meeting can watch the recording later and are caught up. Alternatively, 

an attendee can review the recording if, for example, she cannot recall one of her action items. 

You can specify a location to save these files. Once you have set the location, future 

recordings are saved to that same place. 

 

Save your recorded meetings 

 

1. Under Options, choose Recording, and then click Browse to select a folder that you want 

to store recorded meeting files. 

 

2. You can also select the image resolution (480p, 720P HD, or 1080P Full HD) --keeping in 

mind that the higher the resolution, the larger the meeting recording file size will be. 

 

 

 

 

 

  

 Back to Table of Contents 

javascript:
javascript:


41 | P a g e  
ATTAP-A018-1-A 

2.14 Skype Meetings 
 

You can use the same audio selections with all your Skype for Business meetings or set up 

Skype for Business to give you options every time you join. The latter is handy if you need to 

use a different audio connection, depending on the meeting or location you join from. 

 

Set Skype for Business Meeting options 

 

1. Under When I join meetings, select Show IM automatically opens the IM pane.  If you 

want to see the participant list, select Show the participant list. 

 

2. Under Meeting default, click the Change button if you want to use an app other than 

Skype for Business for meetings, or if you want to use a different version of Skype for 

meetings. 

 

3. Under Joining conference calls, click the drop-down menu next to Join meeting audio 

from, and do one of the following: 

 

• To use computer audio and video (via your computer microphone and speakers or 

a headset) for the meeting, select Skype for Business. 

 

• To call into the meeting, if the meeting request includes a call-in number, 

select Do not join audio, join the meeting, and then use a phone to call in. 

 

• (Optional) If you join from different locations or devices and want to choose how 

you connect to meetings each time you join, select the Before I join meetings, 

ask me which audio device I want to use checkbox. 

 

4. (Optional) Under Meeting reminders, by default, Don't show notifications when 

Outlook is running is selected. To change that, clear the checkbox. 

 
Note:  You can have Skype for Business call you (and set up Skype for Business 

meetings that include call-in details) only if dial-in conferencing is enabled for your 

account. For more details, contact your workplace technical support. 
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Section 3 – Using Skype for Business 
 

3.1 Add a contact to list 
 

In Skype for Business, you can add people to your Contacts list so that they are just a click 

away. Every contact you add is assigned membership in one or more of your contact groups. 

 

Add a contact who is in your organization 

 

1. In the search box, type the person's name, IM address, or phone number. As you type, the 

view automatically changes to My Contacts, which lets you search your organization's 

address book. 

 

              
 

2. Right-click the person's picture  

3. Click Add to Contacts List 

4. Choose the contact group. 

 

 
 

 

Add a contact who has a Skype account 

 

Before adding contacts, who have Skype accounts, your administrator must enable the Skype 

Directory option to search for your organization. If you do not see a Skype Directory tab, 

then this option is not enabled.  
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1. In the search box, type the person's name, email address, IM address, or Skype phone 

number. 

 

                           
 

2. As you type, the view changes to My Contacts. Choose Skype Directory.  

 

                            
 

3.  Right-click the person's picture > Add to Contacts List > choose the contact group. 

 
     IMPORTANT: After you add the person to your contacts list, their status is Pending. 

They are supposed to sign in to Skype and accept your request. 
 

4.  If you sent your Skype contact a request and they never receive it, ask them to send you a 

request to chat. In these instances, that often establishes the connection. 

 

Add an external contact (someone not in your organization or using Skype) 

 

1. In Skype for Business, choose the contacts icons as shown below. Then choose Add a 

contact not in my organization > Other. 

 

                      
 

2. Type the person's email address. (If you do not know it, or they do not have one, you can 

enter a placeholder email address, such as Your Name@army.mil, that you can change 

to their real name later.) 

 

3.   Right-click the contact you just added, then choose See Contact Card. 
 

 

 

1.  

2. 
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4.   Choose Add.          

 
 

 
 

 

5.  Now you can enter additional information for the person. If you entered a placeholder 

email address, type the person's real name in the Name box. Choose Save. 

 
    IMPORTANT: If you get the Check Full Name box, choose OK. Otherwise, your 

changes to the Name box are not saved. 

 

                               
 

 

3.2 Send and respond to Instant Message (IM) 
 

Skype for Business instant messaging (IM) is an efficient way to connect with your contacts 

in real time and on a moment’s notice. Less formal than email, faster than a phone call.  Using 

IM is ideal for speed, convenience, and ease of use. 

 

Send IM to one person 

 

Locate the person you want to send an instant message by locating them in search or your 

Contacts list. You can also find them in your conversation history. 

 

1. Locate the search box on your Skype for Business contacts page, just below 

the Contacts tab. 
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2. Click in the search box and type the group name you want to search. 

3. Hover over their picture in the Contacts list and click the  button on the quick launch 

bar. 

 

4. Type your message at the bottom of the conversation window. 

 

5. Press Enter on your keyboard to send the message. You will see next to each instant 

message a picture of the person who sent it. This works for both one-to-one conversations 

and conferences. 

 

6. (Optional) Add others to the conversation by dragging their contact listing from your 

Contacts list into the conversation window. 

 
Note:  Skype for Business breaks long messages into sections and provides recipients the 

option to read all the text at one time. This message is now called a story and allows the 

recipient to give it a title. 

 

 

Send an instant message to several people at once 

 

To start an IM conversation with multiple contacts, do the following: 

 

1. If the people you want to send the instant message to appear as adjacent contacts in your 

Contacts list, press and hold the Shift key while you click each person.  

2. Then, click the  button next to the last contact you select, type your message at the 

bottom of the conversation window, and press Enter. 

 

3. If the people you want to send the instant message to appear in the list as contacts who are 

not adjacent, press and hold the Ctrl key while you click each contact.  

4. Then, click the  button next to the last contact you select, type your message at the 

bottom of the conversation window, and press Enter. 
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Send an instant message to a group 

 

There are several ways to send an IM to a group. You can search the company directory for 

distribution lists or Office 365 Groups and send the IM to everyone in those groups. You can 

also send an IM to a group of contacts in your contacts list. 

 

1. Search for a group and send the IM.  Find the search box on your Skype for Business 

contacts page, just below the Contacts tab. 

 

 
 

2. Click in the search box and type the group name you want to search. 

 

3. Hover over the group picture in the Contacts list and click the  button on the quick 

launch bar. 

 

4. Type your message at the bottom of the conversation window. 

 

5. Press Enter on your keyboard to send the message. 

 

Send an IM to one of your contact list groups 

 

1. Right-click the group name in your Contacts list 

 

2. Click Send an IM. 

 

3. Type your message at the bottom of the conversation window. 

 

4. Press Enter on your keyboard to send the message. 

 

Respond to an incoming message alert 

 

• When someone starts a new IM conversation with you, an alert pops up on your screen.  

• To see the message, click on Accept in the photo area. 

• To respond back, type in the conversation window, then press Enter on your keyboard. 

• To reject the message, click Ignore in the photo area. If you use Outlook, the message 

goes to your Outlook conversation history inbox (see section 2.2 personal). 
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3.3 Make and receive calls 
 

Skype for Business automatically detects your devices, such as a headset, mic, speakers, and 

cameras. Before you make a call, check your that you have an audio device connected to your 

computer. It is recommended to check your audio and video devices before joining a meeting 

or making a call (see section 2.10 to check audio).  

 
Important: When your admin set up Skype for Business, they determined whom you could 

communicate with using Skype for Business. By default, you can communicate with other Skype 

for Business users in your business. However, depending on your setup, you may not be able to 

use Skype for Business to communicate with people in another business or other Skype users. Ask 

your admin if you have questions. 

 

To make a Call 

 

• To call a contact using Skype for Business, click on the contact’s avatar/picture and select the 

phone button.  

 
Note: To call CONUS/US numbers, dial the 10-digit number; to call DSN numbers, put a 94 before the 10-

digit number; to call international numbers, dial 011, then country code, then the 10-digit number.  

 

Then choose one of the following options for the call: 

a. Work: to call the contact at a work number 

b. New Number: to enter a different number to call that person Skype for Business 

c. Skype call: to call a contact on Skype for Business 

d. Voicemail: to call the contact’s voicemail 

• Select the Video button to add video to a Skype for Business call. 

• Select the IM button to send an instant messaging to a Skype for Business call. 

• Select the Participants button to invite other contacts to join the call. 

 

After the call connects, use the mic button at the bottom of the window to mute/unmute 

yourself  , and the handset button to end the call  . 

 

Use the other call controls as appropriate: 

 

Select the Call Controls button  for the following options: 

 

Hold to place a call on hold. 

Transfer to another number or person. 

Devices to switch to a different device. 

Dial pad to interact with an automated phone system, 

such as entering a code when you call your voicemail or 

calling the office reception desk. 

Speaker volume to adjust the sound. Slide the pointer up and down for volume or select 

the speaker icon at the top of the volume control to mute your speaker.                                   
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Call Forward Options 

 

1.   Open the Options window, by  

clicking on the gear cog in the upper right 

corner of the primary interface screen. 

 

2.   Select Call Forwarding. 

 

3. Make the applicable choice of: 

a. Turn off call forwarding. 

b. Forward my calls to: (phone number). 

c. Simultaneously ring: (phone number). 

 

4. Click OK to save. 

 

 

 

 

 

 

 

 

 

 

Use the Dial Pad 

 

If your Skype for Business account has Enterprise Voice enabled, you can use the dial pad to 

call a phone number from Skype for Business. 
 

Note: If you do not see the dial pad, your organization does not have the correct licenses. 

Contact your technical support team. 

 

1. From the main Skype for Business screen, click the Dial Pad icon. 

 
                     

 

The Dial Pad appears just below the icon. 
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2. Enter a phone number in one of the following ways: 

 

• Select the number buttons on the Dial Pad. 

 

• Type the number on your keyboard. 

 

• Cut and Paste the number from the clipboard. 

 

3. Select Call. 

 

After the call connects, use the mic button at the bottom of the window to mute/unmute 

yourself, and the handset button to end the call. 

 

Receive a call 

 

When a contact calls you, a notification pop up appears on your screen. To answer the call, 

select Accept. 

 

If you do not wish to accept the call, select Decline to dismiss the call and send it to 

voicemail, if available. 

 

3.4 Cannot see video from other participants 
 

Choose the Participant icon. Next to the participants sending video, there is a blue camera 

icon. 

 

              
 

If an icon is shaded, (meaning it is unavailable), that participant cannot send video, or if two 

vertical bars are shown, then there is video capability, but the participant is not using it. 

 
Note:  If an audio-only call, all camera icons are shaded until one participant starts 

sending video. 

                                               
                                                           

 

 

 

 
Back to Table of Contents 



50 | P a g e  
ATTAP-A018-1-A 

Other participants cannot see my video 

 

In the Skype for Business main window, click the Options button  and select Video 

Device. This option allows you to set up and use your computer’s camera to make a video call 

or share your video in a meeting, but you do not need one to receive a video call or see other 

people’s videos.  Refer to section 2.11 video device to diagnose the problem. 

 

3.5 Cannot Hear Participants 
 

If you cannot hear the other participant at all, or cannot hear them very well, there might be 

something wrong with your playback device (speakers or headphones) or settings. 

 

In the Skype for Business main window, click the Options button  and select Audio 

Device. This option allows you to set up and use your computer’s built-in mic and speakers, a 

headset, or another device with Skype for Business. Refer to section 2.10 audio device to 

diagnose the problem. 

 

Background noise 

 

If you hear background noise in a conference call, choose the Participants button, and then 

look at the microphone icon for each participant. 

 

                             
 

The icons indicate activity, and if the background noise matches a non-presenter, then ask that 

participant to mute their microphone. If you are a presenter, you can mute the participant 

yourself. 

 

3.6 Connection Problems  
 

Troubleshoot connection issues in Skype for Business 

 

Are you having problems with your Skype for Business calls? An Internet connection is the 

most likely culprit. A poor Internet connection can cause low-quality audio and video, delays, 

and dropped calls. During a call, the signal strength indicator is displayed. 
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Depending on the severity of the problem, the icon can be white (good quality), yellow (quality 

is satisfactory but could be better), or red (quality is weak). 

 

 

 

Clicking on the indicator  

provides additional information. 

 

 

 

If you have a slow connection, the following tips might help. 

 

• Improve your signal.   

   

If possible, use an Ethernet cable to plug in your computer directly into the modem or 

router. If you are using a Wi-Fi connection, try moving closer to the router to get a better 

signal. 

 

• Close other programs.  

  

File-sharing applications, streaming audio or video or even just having a web browser 

open are all things that eat up bandwidth. Closing them frees up bandwidth so that Skype 

for Business can use it. If you are using Windows 7 or a newer release of Windows, you 

can use the Task Manager to see everything that is running on your PC and the percent of 

usage of CPU, Memory, Disk, and Network for each program. 

 

• Check your speed.  

 

For a high-quality video call, both you and the other participant need to have enough 

bandwidth. Do a speed test online (type speed test into your search engine and pick the 

top few) or ask your Internet Service Provider (ISP) to test your download and upload 

speed for you. Check the result against the speed your ISP is supposed to be providing. If 

you often have a slow Internet connection, ask your ISP to take care of it. 

 

• Update your hardware.  

  

If your computer, modem, or router is old, then everything seems to be running slow even 

with a fast connection. It might be worth upgrading your hardware if all else fails. 

 

• Check with the other participant.   

   

Remember, even if everything is okay at your end, the other participant might have a 

problem with their connection. 
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3.7 Attach a File 
 

Sometimes you need to provide a handout or file to your meeting participants, such as a copy 

of the presentation you are sharing or a document that they need to review. 

 

Attach a file while in the meeting 

 

1. Pause on the presentation (monitor) icon and click Add Attachments. 

 

2. Browse to the file you want to make available for download and click Open. 

 

3. Click Manage Attachments > Permissions to choose who can download the file or 

remove it.   

 

4. Meeting participants can then download the file from the presentation menu on 

the Manage Attachments> More option. 

 

Preload attachments for a Skype for Business meeting 

 

Preloading your meeting attachments in advance gives you time to focus on your meeting 

when your participants join. 

 

1. Set up a Skype for a meeting in Outlook, as you typically would do. 

 

2. On the Insert tab, in the Include section, click Attach File or Outlook Item, and then 

select the attachments you want to add. 

 

                                                      
 

3.  A response message shows that the meeting files are attached to the meeting invitation. 

 

                     
 

4.  You can also attach a file that is in the cloud, such as in OneDrive for Business. However, 

the file is not loaded from the cloud location until the meeting starts. 
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Note: At this time, you cannot present a PowerPoint file from the cloud. You can open 

the file and then share your screen. 

 

5.  That is it. Just double-check the information and click Send. 

 
Note: You can add meeting attachments any time before the meeting by updating the 

original meeting invitation and sending the update. 

 

View the attachments in the meeting 

 

The attachments you included in your Skype for Business meeting invitation show up in the 

meeting window automatically when the first participant joins the meeting. 

 

1. In the meeting window, people can see there are meeting attachments by the notification 

in the yellow band and by the orange dot next to the Present button. 

 

        
 

2. To retrieve the meeting attachments, click the Present button, and then select Manage 

Content. 

 

                                                  
 

 

3. To view the meeting files, click the Open the file button. 
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You can also do other things with the attachments on this page. 

 

 

Click 

this 

To do this 

 

Download the meeting attachment. 

 

  

 

Change who can download the meeting attachment (everyone, presenters, organizer). 

By default, only the organizer and presenters have automatic access to the content. If 

you have participants outside of your organization, make sure to change this to 

everyone.  

 

Remove the meeting attachment from the meeting. 

  

 

More options, such as save as and rename the meeting attachment. 

  
     Note: You cannot save as or rename cloud attachments. Renaming a file is temporary and  

     does not change the calendar attachment file name. Also, if the meeting restarts after  

     renaming a file, it is not retained, and the original name is restored. 

 

 

 Back to Table of Contents 

 

 



55 | P a g e  
ATTAP-A018-1-A 

 

 

3.8 Setup Skype Meeting in Outlook 
 

You can use Outlook or Office 365 Web App to schedule a Skype for Business meeting. If 

your account is configured for dial-in conferencing, the Skype for Business meeting request 

automatically includes the call-in information (phone number and conference ID). 

 

Schedule a Skype for Business meeting using Outlook 

 

1. Open Outlook and go to your calendar. 

 

2. On the Home tab, select New Skype Meeting. If you do not see this option, then refer to 

section 1.2 Verify installation of Skype for Business on PC. 

 

                                                          
 

3. Set up the meeting as you typically would: 

 

• In the To box, type the email address of each person you are inviting, separated 

by semicolons. Alternatively, click on To for global distribution list and more. 

 

• In the Subject box, type a name for the meeting. 

 

• If your organizations have designated rooms for meeting, select Room Finder, in 

the Options section on the Meeting tab, and then find a room, or in 

the Location box, type in a meeting location (a conference room number). 

 
Note: Rooms are set up by your systems administrator. 

                                                               
• Select a start time and end time. 

 

4.  To look at a time that works for everyone, select Scheduling Assistant, in 

the Show section on the Meeting tab. 
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5.  In the meeting body area, type in an agenda or any other message. Be careful not to 

change any of the Skype for Business meeting information. The body area will contain a 

link to Join Skype Meeting, and if assigned by the administrator, a Join by Phone 

number will appear with Conference ID to dial in to hear just the audio of the meeting. 

 

 

 

 

 

 

 

 

 

 

 

 

 

6.  In the Skype Meeting section on the Meeting tab, select Meeting Options, and then 

select the appropriate options. If you have a meeting with people outside your company, 

or you are scheduling a huge event, change the meeting options before sending the invites 

to your meeting.  

 

                                       
 

7. (Optional) Preload your meeting attachments from Insert tab.   

 

8.  Double-check the information before selecting Send. 

 

Set up an online meeting using Office 365  

 

1. Use a browser that supports the full version of Office 365 Web App. 

 

2. Have a username and a password from an organization that has a business or 

enterprise subscription to Office 365. 

 

3. In the Office 365 portal, select Outlook to open the Calendar app. 
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4. On the calendar page, select New > Calendar event. 

 

                                                   
 

5. On the Set up an appointment page, select Add Skype meeting. 

 

      
 

 

6. Fill in the meeting title, location (if you have in-person attendees), and the start and end 

times. 

 

          
 Back to Table of Contents 



58 | P a g e  
ATTAP-A018-1-A 

7. Choose the people to attend, add the agenda or other meeting information, add 

attachments, and then select Send. 

 

3.9 Join Skype for Business Meeting 
 

Join a Skype for Business meeting from a Windows PC 

 

1. In your meeting request, click Join Skype Meeting. 

 

                        

 

 

 

 

 

 

 

 

 

 

 

2.  The Meetings tab allow viewing of current, future and joining meetings. To join a 

meeting, click on the Meetings tab, and then right-click a Skype meeting to join. 

 

                  

3.  The microphone automatically mutes when joining a meeting. To unmute your mic, find 

the mic button,  and click it. When it looks like this  , people in the meeting 

can hear you. Unmute your speakers also. 

4. If you need to switch to a different audio device, click the Call Controls button  , 

and then click Devices.                                               
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5.  The Switch Devices box shows your available audio devices, with the current one 

selected. Choose a different one if you would like. 

 

                                  
 

Audio quality depends on the network and the devices used. 

Best quality - Use a wired network connection and switch off wireless on your 

computer. 

If you must use a wireless connection, make sure you have a strong signal and  

use a high-quality headset for better audio.  
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3.10 Record and Playback a Skype for Business Meeting 
 

When you record a Skype for Business meeting, you capture audio, video, instant messaging 

(IM), screen sharing, PowerPoint slides, whiteboard activity, and polling. Any of the 

presenters can record a meeting and save it on their computers. 

 

1. Click the More Options button and choose Start Recording. If the recording option is 

dimmed, your audio might not be connected. Click the microphone icon to connect audio, 

and then try again. If still having problems refer to section 2.10 Audio Devices. 

 

 

                                     
 

 

2. Use the controls at the bottom of the meeting to pause, resume, or stop the recording. 

 

      
 

 

3. To see if others are recording, point to the red recording button. 
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4. When done, click Stop Recording. 

 

                           
 

5. Skype for Business automatically saves the recording in an MP4 format that plays in 

Windows Media Player. You can exit the meeting while processing the recording. 

 

Play and share a recording 

 

After a recording process has completed, you can access it to play or send to others. Skype for 

Business displays a message when the recording is ready.  

 

• Click on the alert to open the Recording Manager or, 

 

• Open the Recording Manager while in a meeting or, 

 

• From the Skype for Business main window, click on down arrow, select Tools, 

then Recording Manager. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the Recording Manager  

 

1. Click to highlight a recording, and then click Play on the right side of the window. 

 

2. Renaming or deleting of recording are done here. 
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3. To share your recording, click Browse to locate it, and then copy the file.  Paste on a 

shared location, such as OneDrive or an internal SharePoint site. If you cannot post the 

recording, check to make sure you have enough space on the page. 

 

3.11 Present Your Screen 
 

You can show your entire desktop or just a program to everyone in a Skype for Business 

meeting, call, or instant messaging (IM) conversation. You must be a presenter on a Skype 

for Business meeting to share your screen. If the option is grayed out, ask one of the 

presenters to give you control. 

 

Present Desktop  

 

Click on Present Desktop to switch between multiple programs or work on multiple files 

from various programs.  

 

Caution: Sharing your desktop allows everyone in the meeting to see all programs, files, and 

notifications on the desktop. If you have any confidential information that you do not want 

people to see, close those windows or use Present Programs instead. 

 

Present Programs 

 

It is used to present specific programs or files only on your computer. To share one or more 

programs or files, click Present Programs, and then select the specific program or file to 

share. 

 

Share your screen or program 

 

1. At the bottom of the conversation window, click the Present (monitor)     button. 

 

2. Choose one of the following: 

 

To share the content on your desktop, click Present Desktop. 
 

3. On the sharing toolbar, on top of the screen, use any of these options: 

 

• Click Stop Presenting when done sharing your screen. 

 

• Click Give Control to share control of your desktop or program with the participants. 

 

• Click the pin to hide the toolbar and have more space. To un-hide the toolbar, move 

your mouse to the top of the screen. When the sharing toolbar appears, use any of the 

controls you need or click the pin again to keep the toolbar visible. 

 

 

 

 

Back to Table of Contents 



63 | P a g e  
ATTAP-A018-1-A 

Note:  While presenting in Skype for Business, the status changes to Presenting 

(  ), and you do not receive instant messages or calls. You can change this setting in 

the Status options window. 

 

If you want a meeting attendee to share their screen, give them presenter access so that they 

can use the controls.  

 

Share primary, secondary or all monitors 

 

If you have more than one monitor, they all display on the Present Desktop tab, and you 

can choose which one to share. When sharing All Monitors, the sharing toolbar opens on the 

primary monitor only. If you have only one monitor, the Present Desktop tab does not 

appear. 

 

Presenting a PowerPoint slide show in a multiple monitors scenario 

 

This feature allows you to take advantage of multiple monitors while presenting a PowerPoint 

slideshow. Or if you are in a conference room and want to display the slideshow using a 

projector or a large screen device, then present to the secondary monitor. Your PowerPoint 

slideshow appears on the big screen for the people in the room and on the presentation stage 

for the people on Skype for Business. Also, on your laptop, you see the presenter view that 

shows the current slide, your presenter notes, and a preview of the next slide--visible to only 

you. 

 

If you are presenting a PowerPoint slideshow from your office, and you have multiple 

monitors, you can present to your secondary monitor and still see your presenter notes view 

on your primary monitor. 
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The instructions are the same for both scenarios: 

 

1. Outside of Skype for Business, open your PowerPoint deck on your primary monitor (or 

laptop if you are in a conference room). 

 

2. Choose the Slideshow tab, and then click From Beginning. The attendee view of your 

deck appears on your secondary monitor (or the projector if you are in a conference 

room). Your presenter view appears on your primary monitor. 

 

3. From Skype for Business, click the Present icon, then choose Present Desktop. 

 

4. In the Present Desktop dialog, click the secondary monitor—or whichever monitor is 

displaying the attendee view of your PowerPoint deck. 

 

Give and take control of a presentation 

 

If you want another meeting participant to change a file, help you present, or demonstrate 

something, you can grant control to that person. You will both be in control of the sharing, 

and you can take back control anytime. 

 

1. On the sharing toolbar, click Give Control. 

 

2. Select the name of the person you want to give control. 

Skype for Business sends a notification to that person to let them know you are sharing 

control. 

 

3. To take control back, click Give Control again, and then click Take Back Control. 

 
Tip:  You can automatically allow people to take control of your sharing session at any 

time, by clicking Give Control Automatically on the sharing toolbar. We recommend you 

choose this option only in small and casual meetings. To take back automatic permission, 

click Give Control, and clear the Give Control Automatically check box. 
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3.12 Find a Conversation Log 
 

Skype for Business lets you find a previous conversation by browsing your conversation 

history or by searching for your past conversations with a specific person. 

 

Find a previous conversation with a specific person 

 

1. Open Skype for Business, and in your contacts list, right-click the person whose previous 

conversation you want to view. 

 

2. Click Find Previous Conversations. 

 

                                                     
Outlook opens and displays that contact’s conversations with you in the Conversation 

History folder. To track down the specific conversation, enter a term or terms that would 

have come up in the conversation you are looking for, in the search box at the top of the 

Outlook window. 

 

Browse your conversation history 

 

To see a complete listing of your incoming and outgoing instant messages and meetings, 

including ones you might have missed: 

Open Skype for Business, and, above the search box, click the Conversations tab. 

 

               
 

All your conversations appear in chronological order, with the most recent at the top. Phone 

calls you have had also appear on the conversations list. 

 

If you want to narrow the list, click one of the other two tabs in the conversations window: 

 

• Missed    List your missed conversations only. 

 

• Calls List your phone calls only.  

 

 Back to Table of Contents 



66 | P a g e  
ATTAP-A018-1-A 

3.13 Persistent Chat (Chat Rooms) (SIPR & European Only) 
 

Persistent chat is the Skype for Business (SfB) version of a chat room. Persistent chat allows 

you to create or join a topic-specific chat room that all conversations posted are displayed 

when accessed. A benefit of persistent chat eliminates constant notifications for every 

message until you are actively in the open chat room. Also, seeing the chat room’s entire 

conversation history eliminates the repetition of information. If you see the Chat Rooms tab 

in the Skype for Business main window, persistent chat is set up in your organization. 

 

 

 

 

   

 

 

 

 

In a chat room, messages about a specific topic are shared with other chat room participants in 

real-time and saved over time. If you are authorized, you can create chat rooms, participate in 

chat room conversations, view and search chat room history, and monitor conversations in the 

rooms that interest you ─ all without leaving the SfB main window. The ability to have a 

recording of all the IM’s is great for brainstorming and other communications.  

 

 

Chat Room Privacy Settings 

 

Every chat room has a privacy setting, which determines who can participate in it: 

 

• Open rooms – Anyone can find (via search), read, write in (“post to”) and follow. No 

membership is required (or accepted). 

 

• Closed rooms – Non-members can find closed rooms (via search) and see a list of members, 

but only members can follow, read, or post to these rooms. This is the default privacy 

setting. 

 

• Secret rooms – Non-members can’t find secret rooms, learn who has membership in them, 

follow, read in, or post to them. 
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Find and Enter a Chat Room 

 

 

1. In the SfB main window, click the Chat Rooms tab. 

 

2. In the search box, type a room name or keyword(s). 

Relevant rooms appear in the search results. 

 

3. Enter the chat room by pointing to the Chat Room 

icon and then clicking the Open button. 

 

Create a Chat Room 

 

If you’ve been granted authorization to do so by your server administrator, you can create and 

manage your chat rooms. 

1. In the SfB main window, in the chat room view, click the Add a Room button  then 

click Create a Chat Room on the drop-down list. 

 

2. In the My Rooms dialog box, click Create a New Room, then type a name in the Room 

Name box. 

 

3. In the Description box, explain the purpose of your chat room. 

 

4. Select a privacy setting for your room from the three options (Open, Closed, Secret). 

 

5. If your support team has provided access to web apps, select one or more to add in your 

room. 

 

6. Type the name of anyone you want to serve as a co-manager for this room and type the 

names of those you want to make members of the room. (They will be notified of membership 

by SfB.) 

 

7. Click Create. 

 

Create a Topic Feeds to Track Activity 

 

You can set up topic feeds to alert you when new are messages posted in the 

chat rooms you’re following: 
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See Participants in a Chat Room 

 

Once you enter a chat room, the picture header on the chat room window gives a glimpse of 

participants. Each person’s presence status is also shown, as a color bar. Point to a photo to 

bring up the Quick SfB menu. From there, you can start a conversation or display the person’s 

contact card. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Read Chat Rooms Messages 

 

To browse chat history 

 

Open the chat room and read the message directly above the text input area. This is the most 

recent message. Scroll up to read previous messages. 
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1.  On the Chat rooms view of the SfB main 

window, click the Add a Room button,  

then click Create a New Topic Feed. 

 

2. Give your topic feed a name. 

 

3. Tell SfB whose posts you want to follow 

and provide keywords to find the discussions 

you want to keep track of, then click OK. 

 

Your topic feeds appear on the Chat rooms 

view of the SfB main window along with the 

rooms you are connected with. The number 

next to a topic feed shows the number of new 

messages that include the keyword(s) you 

assigned to that topic feed. 
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To find messages about a specific topic 

1. Open a chat room and click the Search icon.  

 

2. Under What rooms do you want to search? Click the room name(s). 

 

3. In the text box, type the word or words you want to search. 

 

4. If you’re searching for more than one word, click the Options button, and then select 

whether you want to search for the exact phrase. 

 

Post a message to a chat room 

 

Posting a message in a chat room is much like sending an instant message. 

The message posts immediately. However, unlike an IM, a chat room message 

becomes part of the chat history for current and future participants to see. 

 

1. Open the chat room you want to post in. 

 

2. Type your message in the text input area in the chat room window. 

 

3. Press the Enter key on your keyboard to send your message. 

 

Follow a Chat Room 

 

Following a chat room involves having SfB automatically notify you there’s activity in a 

room you want to follow. It’s a simple way to stay current on your rooms without having to 

check them for new messages regularly. 

You can define the type of notification you get by changing the settings on the Options > 

Persistent Chat window. 

 

To follow a room 

 

1. In the SfB main window, click the Chat Rooms tab. 

 

2. Type a search term to find the room you want to follow. 

 

3. Right-click the listing for that room and click  

    Follow this Room. 
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Use Custom Notifications 

 

By default, you’ll get messages about the chat rooms you follow based on the 

settings in the Persistent Chat Options window. However, you can also customize the alerts 

for a specific room. 

 

1. Right-click the listing for the room, and then click Change Notification 

Settings. 

 

2. On the dialog box, select Customize settings. 

 

3. Choose the alert options you want, and click OK 

 

3.14 Using Polling 
 

   Polling is a great way to get people involved and interacting with your Skype for Business    

   (SfB) meeting and find out what they think about the ideas or create additional dialogue to a  

   meeting. You can create multiple polling windows before starting a SfB meeting or create it  

   during a meeting. 

 

Create a Poll during a meeting 

 

     1.  In the meeting window, click the Present Content button . 

 

 

 

 

 

 

 

 

 

 

 

     2.  Click More, and then click Poll. 
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      3.  In the Create a Poll window, type your question and the answer choices and then 

      click Create. The poll page opens in the meeting and results are shown to everyone as the 

      participants select an option. 
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      4.  Click Poll Actions to manage the poll, such as open, close, edit, show, or hide results. 

 

 

 

 

 

 

 

 

 

 

 

 

       

     5.  When you are finished, click Stop Presenting at the top of the meeting room. 

 

     6.  To delete a poll page, click the Present button, click Manage Content, and then click 

          to Remove. 

 

 

 

 

 

 

 

 

 

     7.  To hide a poll page, click on the display button.                      

 

     8.  To change who can download the poll, click on the lock button. 

 

     9.  To rename or see properties of a poll page, click on three dots button. 

 

 

  

l 
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3.15 Using the Whiteboard 
   

The whiteboard is a blank page that allows you and other meeting participants to type notes, 

draw objects, or import images. When the session is over, you have the option to save the 

whiteboard data from the meeting. 

 

    Using whiteboard as a presenter 

 

     1.  In the meeting window, click the Present Content button .  

 

     2.  Click More, and then click Whiteboard.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

     3.  A blank whiteboard opens on the meeting stage on everyone’s screen. 
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   4.  The annotation toolset opens automatically on the right side of the whiteboard. 

 

5.  Click any of the tools to annotate on the whiteboard, such as pointer tool, pen, 

 highlighter, eraser, and so on. The whiteboard automatically closes if you switch to another 

presenting option but will be available if you want to open it later in the meeting. Just click 

Present > Manage Content to reaccess the whiteboard. 

 

    Use the annotation tools 

 

      Use the tools along the side of the whiteboard to visually focus on the page or brainstorm 

      with the participants. Many people can work on the whiteboard at the same time, but each 

      tool can be used only by one person at a time. 

 

• Laser Pointer    A virtual laser pointer. Click and drag the pointer across the page. A 

blue circle appears in the meeting indicating your name. 

• Select and Type    Selects an area to type. You can change font, size, and color by 

clicking the arrow next to the Select and Type to open the menu. 

• Pen    Draws freehand. Click and start writing or drawing in black, or click the down 

arrow next to the button, and then select another color.  

• Highlighter    Highlights a specific area of the current slide. 

• Eraser    Removes specific annotation you choose.  

• Stamp    Inserts a stamp on the page: Arrow, Check, or X. Choose an option from 

the menu, then click on the whiteboard to stamp.  

• Shape    Draws shapes such as lines, arrows, and squares. Click the down arrow next 

to the button to select another shape or color. 

• Insert Picture    Inserts an image on the slide from your computer.  

• Delete Selected Annotations    Removes the annotations that you’ve selected. 

• More Options    Provides options to select the annotation, undo, redo, copy, cut, paste, 

paste an image, Save As, and Send to OneNote. 

 

    Move or Delete drawings 

     

You can select, then move or delete any of the drawings on the whiteboard. 

        Move objects 

Click the Select and Type button, and then click one or multiple drawings that you want to 

move. A selection rectangle appears around the selected objects. 

Drag the rectangle to a new position. 

Note:  For typed text, point to the bar at the top of the text box before you begin 

dragging it. 

       Delete an object 

Click the Select and Type button, and then select the drawing that you want to delete. 
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Press Delete on your keyboard. 

    Who added or changed content? 

To see who added or changed content on the whiteboard, do one of the following: 

For non-text items on the whiteboard, hold the mouse pointer over the drawing to see 

“Created by” and “Last modified by” information. 

For text, point to the text, and then hold the mouse over the solid rectangle that appears 

above the text when you point at it. 

    Manage your whiteboard 

1. Click the Present button, and then click Manage Content. 

2. Click the Permissions menu, and then choose who can download the whiteboard to 

their computer:  

• Organizer    Only the person who scheduled the meeting can download.  

• Presenters    Any of the presenters in the meeting can download. 

• Everyone    Anyone in the meeting can download.  

3. Click the More button, and then choose an option: Save As, Send to OneNote, or 

Rename. 

 

 

3.16 Using Question and Answer (Q&A) 
The Q&A (question-and-answer) feature in Skype for Business provides a structured 

environment for answering questions during a meeting. This feature is especially helpful in 

large meetings where a presenter can answer questions, while someone else is presenting 

meeting content. Keep in mind that attendees can ask questions, but only presenters can 

answer. 

 

    Start the Q&A session as the presenter 

 

    Any of the presenters in a meeting can start the Q&A session and reply to questions. If you 

    are attending a meeting and are not a presenter. 

   1.  In the meeting window, click the Present Content button .  

 

   2.  Click More, and then click Q&A 
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If no other content is presented, the content stage opens and displays the Q&A session for 

all participants. If other content is active, the Q&A tab displays as a new tab next to the 

Presentation tab at the bottom of the Q&A window. 

The meeting IM automatically turns off until you stop the Q&A session. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.  When a question is submitted, any of the presenters can click Answer and type a reply. 

Then press Enter on the keyboard to post the answer. 

 

 
 

If you are presenting content when a question is submitted, you will see a notification 

about the new question. You can click the Q&A tab at any time to answer the question and 

then go back to the Presentation tab to continue your presentation.  

 

4.  If you start typing an answer and change your mind, click Cancel and answer later, or 

allow another presenter to answer the question.  

 

5.  When a question has been asked, you will see an All tab and an Unanswered tab at the 

top of the Q&A window. Click the Unanswered tab to filter for the questions that have not 

been answered.  
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6.  At the end of the session, click Stop Q&A. When Skype for Business asks if you want 

to enable IM, click Allow All Meeting IM, or click X on the notification if you want to 

keep the IM off. 

 

 
 

7.  If you want a record of the Q&A session, click Save As, type a name and save the file 

on your computer. Q&A is saved in Notepad and contains the questions, answers, time 

stamps and the names of attendees and presenters who participated. 

 

    Participate in the Q&A session as an attendee 

 

When the Q&A session is shared by a presenter, all the meeting attendees can view and 

ask questions. Keep in mind that you can switch between the Q&A and Presentation tabs 

at any time during the meeting.  

 

 
 

1. Type a question in the Ask a question box.  

 

2. When the question is answered, you’ll see the response below your question.  

 

3. If you only want to see your questions, click the My Questions tab.  

 

4. To have a local copy of the questions and answers, click Save as, and select a location on 

your computer.  
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3.17 Skype for Business Conference Call  
You can quickly start a group call to work on a subject that requires immediate attention. Add 

sharing to make it an impromptu meeting that provides all the features of a scheduled meeting, 

including shared PowerPoint slides, whiteboard collaboration, and desktop sharing. 

 

    Start an SfB Conference Call 

 

Make sure your contacts are available by checking their present status first. Then follow 

the steps below to invite them to the conference call.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. In the Skype for Business main window, in your Contacts list, hold down the Ctrl key 

and click the names of your contacts to select them for your meeting. 

 

2. Right-click the selection and click Start a Conference Call. 

 

3. Click Skype Call.  

 

Your contacts then receive a notification and can accept or decline your request for the 

conference call. 

 

    Add more people to the SfB Conference Call 

If you need to add more people to your conference call, you can drag their names into the 

meeting from your Contacts list. Alternatively, add them by using the people menu:  

 

1. In the conversation window, in the Participants pane, click Invite More People.  

 

2. Select someone from the list, and then click OK. Skype for Business calls the person 

for you and adds them to the meeting.  
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3.18 PSTN Conferencing and Calling (CONUS & European Theater Only) 

 

Public Switch Telephone Network (PSTN) Conferencing lets you dial into the meeting with 

your phone by calling a specific number. The PSTN Conferencing feature is an add-on 

telephone service and when combined with Skype for Business Cloud PBX, becomes your 

phone system. Providing a conference call number is essential if you have poor internet 

connections and need a clear voice for your meeting. 

 

In Office 365’s Skype for Business Online, PSTN Conferencing is an add-on as a per-user 

licensing basis. In Skype for Business 2015 Server, the feature is called “Dial-In 

Conferencing,” and requires a Mediation Server and a PSTN Gateway to work. The Mediation 

Server is required for Enterprise Voice, and a PSTN Gateway translates signals between 

Enterprise Voice and a PSTN or PBX. If you want to call out, you’d need both. 

 

PSTN calling is another feature that provides employees in your business with a primary phone 

number to receive and make phone calls outside of your organization. There is a difference 

between PSTN conferencing, a service/feature used for joining a meeting and PSTN Calling, a 

feature used for making/receiving a phone call like a Private Branch Exchange (PBX). 

 

    Make a PSTN Call 

See section 3.3 make and receive calls or click on this link 

 

    Start a PSTN Conference Call 

 

The following is a step by step process to add PSTN conferencing to a Skype meeting 

using Outlook Web Access (OWA) and the Outlook desktop client.  

 

Outlook Web App Process (type outlook web app in your web browser to find) 

 

1. Open your outlook calendar and select the day from the month you would like for the 

Skype meeting. 
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2. Right-click the day of the meeting and select “New.” 

        

3. Enter the details of the meeting including the name of the meeting, location, start date 

and time and meeting stop date and time. All day and Private are options as well.  Other 

controls for the meeting can be set too like Repeats if the meeting will be a regularly 

scheduled meeting along with reminders for the meeting.  Additional notes about the 

meeting can be entered into the text box below the details.  

Back to Table of Contents 
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4. To Add the Skype option to the meeting click on the tab at the top labeled “Skype 

Meeting” and then “Add Skype Meeting.”  

          

   

5. The Conference Phone number and the conference ID will auto-populate in the text box 

of Outlook. This is part of having the license.  Note:  The Conference ID will differ from 

meeting to meeting. 
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6. To add attendees to the Skype meetings easily done through the “People” field. The 

Attendees last name, first name, email or parts thereof will search names of attendees you 

want to add to the meeting. 

           

7. Hit the “Send” button to send out the invite to the meeting. 

           

 

8. Finally, we see our meeting appear in the outlook calendar. 
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Outlook Client on the Desktop 

The following will be a step by step process to add PSTN conferencing to a Skype session.  The 

outlook client is slightly different from the web app. 

1. While in the Outlook Calendar tab select the “New Skype Meeting” tab. 

 

2. In the “To” field add the email of those you want to attend the Skype meeting. Fill in the 

rest of the details for date and time. The Phone number and Conference ID will auto-

populate for the skype meeting.  Hit the send button to complete the meeting. 
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Appendices 
 

Appendix 1 – Abbreviations 

 

AESD - Army Enterprise Service Desk  

FQDN – Fully Qualified Domain Name 

IM – Instant Message 

IMAP – Internet Message Access Protocol 

PC – Personal Computer 

PBX – Private Branch Exchange 

POP – Post Office Protocol 

PSTN – Public Switch Telephone Network 

SfB – Skype for Business 

SSO - Single Sign-On 

US SCSS – Unified Capabilities Soft Client Subscription Service 
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Appendix 2 – UC SCSS Concept of Operations 
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Appendix 3 - NOC Incident Management Process 
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